Multiple files are bound together in this PDF Package.

Adobe recommends using Adobe Reader or Adobe Acrobat version 8 or later to work with
documents contained within a PDF Package. By updating to the latest version, you'll enjoy
the following benefits:

- Efficient, integrated PDF viewing
- Easy printing

« Quick searches

Don’t have the latest version of Adobe Reader?

Click here to download the latest version of Adobe Reader

If you already have Adobe Reader 8,
click a file in this PDF Package to view it.



http://www.adobe.com/products/acrobat/readstep2.html


Appendix A — POD Interviews

Interviews were conducted to survey a diversity of Point Of Diversion (POD) uses
throughout the department. Twelve people from IDWR were interviewed:

1. Technical Hydrologist — Hydrology Division
e Water modeling of curtailment scenarios
2. Bureau Chief - Planning Division
e \Water projects constructed by the Water Resource Board
3. Section Manager - Adjudication Division
e Water rights and adjudication in the State of Idaho
4. Hydrologist Tech - Planning Division
e Water Accounting
5. State Floodplain Coordinator - Floodplain Division
e Flood Plain mapping and Flood Modeling
6. Senior GIS Analyst — Geospatial Technology Division
e Adjudication and Water rights
7. Section Manager — Water Rights Division
e Water Rights in the State of Idaho
8. Section Manager — Water Distribution Division
e POD Regulation, Water Measuring
9. Hydrogeologist — Groundwater Protection Division
¢ Injection Wells, Well-related customer service
10. Systems Programmer Supervisor — Information Technology Div
e Programming
11. Deputy Attorney General — Legal Division
e |daho water law issues
12. Section Manager — Hydrology Division
e Water Modeling and Accounting

1. A Point of Diversion (POD), is often defined as “the location where water is
diverted from the natural source”. Do you agree with this definition?

All respondents agreed with this definition. One respondent added that a POD can also
be defined as the location where water is diverted from a public water source but
stressed that he is not suggesting the current definition should be changed.

1.b What is a natural source?

Most respondents replied that any natural stream, including its tributaries, is considered
natural. Water is “chased” up tributaries as far as possible and all those tributaries are
considered to be natural. All respondents agreed that a natural source can be perennial,
intermittent or ephemeral. All respondents agreed that wells and springs that deliver
water from a natural source, as well as lakes and ponds filled by water from natural
sources are considered to be natural themselves. In general all respondents agreed that
canals, ditches and laterals are man-made, and therefore water diverted in these
structures is not considered to be natural.

One respondent pointed out that, while a “POD” is more rigidly, although not legally,
defined; the definition of a “natural source” is not. This same respondent offered the





following definition for a natural source: “Any unregulated flow that would exist if there
were no reservoirs or diversions, in other words, any flow that would exist if man had not
interfered”. In some cases it can be hard to determine what is “natural” and what is not.
Here are a couple of examples where it can be quite confusing trying to determine
whether water is natural or not:

e The Great Feeder Canal in south eastern Idaho has a natural, i.e. not
man-made, streambed although it has been altered by men. Water is
diverted from the Snake River into the Great Feeder Canal which would
indicate that this canal is not natural. However, the Great Feeder Canal
also flows through an area with high ground water levels, which causes a
natural inflow of water into the Great Feeder Canal which would indicate
that at least portions of the water within this canal are natural.

e Thousand Springs is named for the numerous streams and rivulets
coming out of the east wall of the Canyon and flowing into the Hagerman
Valley between Bliss and Buhl in Idaho. These springs are outlets from
the Snake River Plain Aquifer which is fed by natural streams such as the
Lost River but also through recharge of water that at some point flowed
through man-made canals and is thus not considered natural.

One respondent pointed out that Chapter 1 (42.103) of the Idaho Water Code specifies
which water sources are subject to appropriation, and thus need to have a defined POD
for using this water, and which water sources are exempt and can be used without a
water right and its corresponding POD. The Idaho Code exempts private water such as
swales or depressions where run-off water is collected. This “private water” needs to be
limited to a private property. Another respondent mentioned that there are cases where
a stream starts and ends on the same property, for example a small ephemeral stream
or spring starts, but also “dies out” before leaving this property. People can use this
water without needing a water right or a corresponding POD.

It is possible to guide natural flow through a man-made structure. For example, a natural
stream can flow into a pipeline for some distance and still be considered “natural” as
long as this pipeline does not change the direction of the flow. Similarly, certain portions
of a natural stream can be channelized and remain ‘natural’ as long as those streams
maintain the path of their natural flow.

Our floodplain expert added that anything that has been mapped by the Federal
Emergency Management Agency (FEMA) is considered to be a natural source. For
example, Five Mile Creek in Canyon County in Idaho is mapped by FEMA, and hence
considered natural, even though it is also being used by an irrigation district to divert
irrigation water. More information about FEMA’s mapped natural streams can be found
at www.msc.fema.gov. According to FEMA, natural streams can be used for conveyance
and storage of water during a flood event. Also, natural streams have a natural
geomorphology and have biological significance for species that live in or nearby a
natural stream.

All respondents agreed aquifers are natural, and that springs and wells used to extract
water from those aquifers are points of diversion. The exception would be wells drilled
for domestic use where the water is used on an area less than 0.5 of an acre since those
wells do not need a water right and a corresponding POD. One respondent added that
this situation is not always clear cut, since water used for irrigation can provide recharge
to the aquifer. . One respondent pointed out a situation where people may be pumping
water at a site without a POD. It is common that during the construction of a gravel pit,
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water fills this pit. Diggers typically pump the water out of the pit so that they can keep
digging. In this case, water is pumped, but not used.

Similarly, lakes and ponds fed by natural sources are also considered to be natural. One
respondent added that water flowing through old mining tunnels can be considered
natural. Another interesting scenario is aesthetic ponds which are created when
someone digs a hole in the ground which then fills up with ground water. Since this
groundwater is a natural source, the owner of the pond may need a water right if it is
greater than a specified minimum size.

A special case is where water is diverted from one natural stream into a man-made
structure that carries the water to another natural stream. The point of re-diversion if
defined as the spot where water flows from the first natural stream into the man-made
channel, and the point of re-injection is where the water flows from the man-made
structure into the second natural stream.

Some disagreement consists among the respondents in regards to situations where the
water in drain ditches and waste water channels are considered natural.

2. Scenario’s
All interviewees were asked to identify the POD in the following scenarios:

Scenario 1:

Place of Use is he‘r‘e‘\
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All respondents placed the POD at the location indicated by the red circle. It is very
common in Idaho to have an irrigation district or canal company to hold a large water
right and then deliver water to their shareholders. All interviewed people agreed that
placing the POD at the red circle suits their business processes. For example, in a water
accounting model a stream network is divided into reaches and the model computes the
water gain and loss for each of those reaches based on inflow (from upstream reaches
or storage) and outflow (water usage).





Scenario 2:
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This scenario differs from the first in that “Farmer Joe” has his own water right and is
thus not a shareholder in a water right held by an irrigation entity. This situation does
occur, for example in the Northside Canal Company where Farmer Joe will pays a fee to
the Northside Canal Company for the use of their lateral, but has his own water right.
This situation also occurs when homeowners have a water right because they like to
have water in a canal near their home in the winter for aesthetic purposes. All parties
agreed on the location of the POD (indicated by the red circle), and all agreed that this
works for their business processes.

Scenario 3:

Scenario 3 Canal Company A
Lateral A.1
« Canal Company B e
< Lateral B.1
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Snake River
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In this scenario water flows from the Snake River into Canal A where water is first
diverted into Canal Company B, and then diverted to Canal Company A. All
respondents agreed that the point of the diversion for both Canal Company A and Canal
Company B was in the location indicated by the red circle.

This example illustrates that it is possible to have multiple PODs, for all water right
holders for whom water is diverted at a given point, at exactly the same location. One
respondent mentioned as an example the location where the Eastside Canal diverts
water from the Big Lost River. It is the goal of IDWR to have an identical location for





each of those “stacked” water rights, but there are still numerous instances where those
PODs are spatially scattered.

Talking about scenario 3 quickly evolved into a discussion about drains and waste water
channels and whether those channels are natural and therefore could have PODs. The
following graph was not part of the interview, but captures details that were obtained
during some of the interviews:
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Farmer Joe holds a water right to the water leaving Canal Company B. One respondent
mentioned that the portion of Canal A running past Farmer Joe could be called a
conveyance drain and that it is not uncommon to have points of diversion on the
conveyance drain. Farmer Joe’s water right would be junior to that of both Canal
Companies. Two respondents disagreed and said that Joe’'s POD would still be at the
point where Canal A leaves the Snake River.

Most respondents agreed that it is more likely to have situations where Farmer Bob
would have water from two different sources: (1) water from the Snake River that is
specifically diverted for him, in which case his POD is where Canal A intersects the
Snake River, or (2) waste (or “leftover”) water from water that was diverted specifically
for Canal Companies A and B. In this case, Farmer Bob’s POD can be on his property
along Canal A. Farmer Bob’s water right is typically junior to the water rights held by
Canal Company A and B. So, if there is a shortage of water, then Farmer Bob may not
receive water.

One respondent disagreed. Water applied to land in Canal Companies A and B, but that
are not used by plants or evaporated will seep into the drain that runs past Farmer
John’s property. This respondent argued that it is along those types of drains that PODs
are allowed.





3. What do you call diversions that divert water from a man-made canal or lateral,
and are those types of diversions relevant for your business purposes?

Since man-made canals are not natural, diversion structures such as check gates and
pumps are NOT referred to as “points of diversions’ per department policy. Currently,
there does not appear to be a unifying term for such structures, although some
suggested terms were “field head gates”, “POD but with a different meaning”, “artificial
hydrography” or “heading”. Most respondents suggested to just to call them what they
are, for example, “pump”, “dam” or “check gate”.

Locations of these diversion structures can be useful in water modeling. For example,
when planning a recharge project where water is diverted through canals for the purpose
of recharging the aquifer, the amount of water that is diverted through the canals is
needed. This type of information would be extremely useful for canal companies and
irrigation districts where such recharge projects are being planned by IDWR. While
diversion structures can be useful in some applications to water modelers, the most
useful product is system maps showing where canals and laterals are, and how they
interact.

Planning and flood plain modeling also agreed that information about these diversion
structures can be useful. Currently FEMA only maps natural streams, but canals and
laterals play an important role during flood events and the locations of canals and
laterals, as well as diversion structures along those channels, are crucial. For example,
by only looking at natural streams, FEMA has concluded that the City of Caldwell, Idaho
is in a flood plain because during a flood event water from Indian Creek would flow into
the City. FEMA does not take into account that during such an event, the New York
Canal can divert water away from the city and help prevent flooding. Information about
diversions of man-made canals and laterals could probably also be used in FEMA's
HAZUS model which simulates flood impacts.

Some respondents stated that as we get more types of diversion data collected, more
uses for these datasets will become apparent.

4. Which of the following items do you consider to be PODs, assuming that they
are located on a natural stream.

One respondent provided the following general definition: “Anything that diverts water
from a natural source. This could be a large dam but also things like sheets of plastic,
pipes or — in one case — a bus parked in a natural stream”. Another person added “.. a
person holding a water right must demonstrate that they are capable of diverting the
specified amount of water from the location specified in a water right. It does not matter
how this person does that. So, if this person hauls water out of the stream manually
using buckets, that would also be considered a POD.”

Head gates All respondents consider this to be a POD. One respondent
pointed out that the location of a head gate is not always the
same as a POD. This is explained in Box 1 below this table.

Check gates Respondents were divided, 60% said “yes”, and 40% said “no”.
One person stated that check gates are not points of diversion






because they are not used to divert flows, but only control flows.
Another person specified that as long as it diverts water into an
associated canal itis a POD.

Other gates

Some respondents stated that there are different variations of a
head gate. One person mentioned a “Calliope Gate” as found in
Indian Creek.

Pumps

All respondents agreed that pumps can be points of diversion.
This includes lift pumps, as long as they are used to divert water
out of a natural stream.

Dams

All respondents consider this to be a POD. One respondent
pointed out that the location of a dam is not always the same as
a POD. This is explained in Box 1 below this table.

Gages

All respondents agreed that gages are not points of diversions.
One mentioned that the casing in which the gauge resides could
divert water. Some mentioned that gauges are frequently placed
at the same location as a structure that would be classified as a
POD.

Weirs

All respondents agreed that weirs are not PODs, although they
can be in the same location as a diversion structure.

Wells

All respondents agreed that wells are PODs.

Fish Screens or
Fish Traps

Most respondents agreed that fish traps or screens are not a
POD. One respondent added that there are cases where a
considerable amount of water is diverted away from the natural
stream for fish purposes, and that it could be some distance
before this water re-enters the same natural stream.

Others

The floodplain expert stated that diversion structures such as
levees, culverts, push-up dams, flumes and storm water
retention structures are relevant to her work. A different person
mentioned that there are water wheels in Oregon which are
considered diversion structures, but this person was not aware of
any such structures in Idaho.
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The figure on the left shows that the check dam diverts water, but the head gate may be
upstream.

The figure on the right shows a rock wing dam where water flows separated for about a
mile before it enters a canal (going NW). Water can still leave the “diversion” on the left
side of the natural stream and flow over the rock wing dam into the right hand side of the
stream that continues NE as a natural stream. Is the POD at the south end of the dam,
or at the point where it turns left into the canal?

A good example of where a Water Management Information System (WMIS) point is not
the same as the POD is Thousand Springs. The POD is where the water leaves the
rock, the WMIS point is on the ground where the measuring station is.

Box 1: Cases where dams and gates are not in the same location as a POD

5. How should Idaho deal with water entering and leaving the State of Idaho?

There are a variety of situations where water is diverted from a natural stream in a
neighboring state, but has a place of use in Idaho. For example, the Upper Teton River
originates in Wyoming, and contains water that is diverted from Jackson Reservoir in
Wyoming.

Frequently such a POD is “located” in the database on the State boundary, while the true
location where water is diverted from a natural stream falls outside the State. Two
respondents explained that it is currently not possible to store PODs in certain locations
out of state since the attribute field storing the information about the Range (of the PLS
system) can only hold 2 digits, but many out of state locations have a Range that is
greater than 99. The solution for this problem is described in “Condition F15” which is part
of a water rights description.






Multiple respondents stated that placing the POD on the border produces limited
information and the POD database should be fixed to allow storage of out-of-State
locations. This person added that not just POD databases, but many GIS layers stop at
the border while they should at least include complete basins that are of interest to Idaho.
For example, GIS layers should encompass the entire Upper Snake Basin.

Another respondent stated that, although he wished the POD was located at the actual
place of diversion, having it at the State boundary is not causing grief. What is challenging
is how to deal administratively with such interstate issues.

Idaho maintains agreements with bordering states about the amount of water that flows
across state boundaries.

For water leaving Idaho, the POD should fall at the location where water is diverted from
the natural stream, even if the place of use is in a neighboring State. This situation is
described in, “Condition F16” of the water rights description. In those cases, the place of
use is manually digitized, and can generally not be entered into the legal description
because there are not enough digits to store the neighboring state’s township information.
For these locations, the first digit of the township is left off and the POD is designated with
additional attributes to compensate for the digit limitation and differentiate the location.

One respondent mentioned that we have started to spatially locate PODs out of State, for
example PODs found along Jim Bob Creek in Nevada. The problem is that PLS
coordinates are not unique; so IDWR has added an additional “County” and principal
meridian attribute field that will help users verify the location.

All respondents agreed that it would be better if the legal and spatial location of a POD
would fall in the correct location, even if this location is outside Idaho.

The Planning, Water Rights, and Adjudication divisions feel that the way IDWR currently
deals with out of State PODs work for their business processes. Other departments, for
example, Water Accounting Modeling, stated that this data would need to be modified to
work for their business purposes.





6a. Which IDWR databases containing POD data do you use?

Table 6.1. Database use per discipline. Table 6.2 explains the footnotes listed in table 6.1
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Feature Dataset
SpatialData X X X X
-Unique ID & spatial locations for features of interest to
IDWR business processes.
WMIS (Water Measurement Information System) X X X X X X X
- Annual volume data for primarily groundwater wells, incl.
some springs
*Water Rights — Application X X X X X X
*Water Rights — Permit X X X X X X
*Water Rights X X X X X X X
*Water Rights - Transfers X X X X X X
*Adjudication Claims X X X X X X X
*Adjudication Recommendations X X X X X X X
*Adjudication Transfers X X X X X X
Well Construction X X X X X X
Wells managed by the USGS X X
Wells data managed by S. Baker X X
Ground Water Monitoring Wells X X X
Geothermal Wells X X X
Wells in Public Water Supply Data X X X
Wells maintained by other agencies X X
Underground Injection Control Wells X X X






Gages maintained by the USGS X X X X

Dam Safety Database X X X

Table 6.2: Footnotes for Table 2.1

* IDWR Water Rights Databases:

Shapefiles for Water Rights (WR) were originally developed from GCDB QQ
for Place of Use (POU) or GCDB QQ/QQQ centroids for Points of Diversion
(POD). If better information is available, irrigation POU and PODs are screen-
digitized from Aerial Photos or GPS locations. WR can be in one or more of
five process or stages; Application of new WR or transfer, Permit (water use is
allowed to develop), License (IDWR has approved final configuration and
amounts), Claim (WR has been claimed in an adjudication), Recommendation
(what IDWR recommends to the court. A recommendation, when approved by
the court, supercedes it’s License.

1 Water Modeling:

Water Modeling uses other information, such as gages maintained by Idaho
Power. In addition, IDWR measures sites and maintains in-house data
regarding these sites, but this data is not part of an agency-wide database. It
is, however shared among a smaller number of IDWR employees.

2 Planning:
The Planning group uses information maintained in the “SpatialData” dataset
secondary to project-specific data. For example, PODs in the area of interest
are GPS'd and stored into a local database. This data is not currently part of
an agency-wide database. Planning also uses other information, such as
gages, maintained by Idaho Power and IDWR. The IDWR gage data is not a
part of an agency-wide database, but is shared among a smaller number of
IDWR employees.

3 Water Accounting:

The representative for Water Accounting was a programmer who builds water
accounting models. The models are used for billing and allocating water
throughout a basin. .

Water Accounting also uses information regarding gages maintained by the
Bureau of Reclamation or by individual irrigation entities.

4 Floodplain:
Floodplain mapping and modeling does not currently use any of the IDWR
listed databases. They do use data that they collect themselves and data they
receive from FEMA, Bureau of Reclamation and Corps of Engineers. They
also use gage data from the Northwest River Forecast Center
(http://www.nwrfc.noaa.gov/).

5  Adjudication/Water Rights:

Adjudication/Water Rights uses Groundwater Monitoring, Geothermal Wells,
Idaho Department of Agriculture, and Public Well Supply data maintained by
the Idaho Department of Environmental Quality. They also use data from the






Bureau of Reclamation, the Bureau of Land Management, the Idaho
Department of Parks and Recreation, and the IDWR Underground Injection
Control Wells Database for the wells that have been issued permits.

Table 2.2 Continued

6  Water Rights:
Water Rights maintains a spreadsheet with temporary appropriations, for
example, annual renewals. Those appropriations are only meant to be valid for
a limited time, for example an appropriation for dust abatement during
exploratory drilling.

Information about pumps and dams can be found in the description associated
with a water right but not directly in the Water Right Database.

7 Regulation and Water Measuring:
Additional gage information used by Regulation and Water Measuring include
Eastern Snake Plain Aquifer (ESPA) monitoring stations and those maintained
by Idaho Power and IDWR. There are plans to include the ESPA monitoring
stations in the “SpatialData” dataset in the future.

Regulation and Water Measuring sections within IDWR receive annual reports
from Idaho Power Company (IPCO) and other utilities in Idaho showing power
consumption records for irrigation wells. Based on this data how much water
that has been pumped for individual wells can be estimated and Power
Consumption Coefficients (PCC’s) are developed.

The Groundwater Monitoring and Geothermal Wells databases are in the
process of being linked to the Well Construction database. The goal is to
coordinate and link information between separate well databases and link them
through identifiers within the Well construction database and the “SpatialData”
dataset.

Underground Injection Wells (UIC) information is not currently part of an
agency-wide database.

6b Are there any databases you would like to have?

Our floodplain expert would like to have a way to map cross sections of a floodplain, and
the location of PODs in each cross section. She also mentioned she would like to have
more LIDAR data.

Planning indicated they would like to have a database showing historical diversion rates
and allowable rate of flow (cfs) for POD’s.





Floodplain Mapping would like to have additional structural information about PODs, for
example whether a weir is made out of concrete, or whether a dam is made of earth or
other material. Flood plain mapping is also interested in information about volume and
flow rates, as well as season of use for various PODs.

Our Wells expert would like to see a database that allows him to cross-reference A-tag
ID’s with other tags (for example D-tags or E-tags). This would allow him to answer
guestions from customers who supply him with the A-tag ID for the well in question.

7. Sources of points of diversion data

POD data is collected when somebody applies for, or transfers a water right. Historically,
the locations of those diversions were identified by the quarter quarter (QQ) in which
they are located. A QQ, which has a surface area of 40 acres, and is the sixteenth of a
section found in the PLS system.
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Figure 7.1. Quarter quarters are one sixteenth of a section in the PLS system.

Given the age of many water rights, and the spatial data available at the time those
water rights were recorded, it is not surprising that some water rights may not have been
recorded in the correct QQ. One respondent explained that during the last 10 years, the
location of a POD has become more accurate. With only QQ data available, a POD is
frequently placed in the center of the QQ, which may or may not coincide with a stream
or other natural source described in the water right.

More recently IDWR has sent out agents to GPS POD locations, and several
respondents would like to have available resources to do this for all PODs. One
respondent added that those GPS points can only be used when it is part of a beneficial
use report that has gone through a legal process. Another person stressed that an agent
should be absolutely sure they are GPS-ing he correct structure. IDWR maintains
information about whether a GPS point was added into the enterprise database
manually or electronically. Our systems programmer added that data is collected through
the various “work flow” processes at IDWR in order to enter data into our enterprise
database.

Information about Underground Injection Wells (UIC) is collected by IDWR employees,
or supplied to IDWR by well drillers. Most wells that were drilled more than 10 years ago
are spatially located based on a PLS description and are plotted at the center of a QQ.
This often causes problems when answering customer inquiries about a specific well,





since there could be as many as 10 different wells stacked in the center of a QQ. In
those cases, it can be difficult to determine ownership of each well. More recently, wells
have been spatially located using GPS. In 2009, IDWR changed its rules and will now
only accept new wells that have both a PLS and a GPS location.

Respondents have mentioned that we could benefit by modifying some of our business
processes by reviewing and possibly incorporating accurate diversion location
information from other agencies. We also have some constraints on POD location
based on locations identified by public land survey locations.

One respondent pointed out that sometimes a POD does not appear to be tied to a
stream, because the stream may not appear in the NHD because it is too small.

Various respondents agreed that it would be interesting to see what percentage of PODs
need to be moved, and how far they would need to be moved in order to be tied to the
NHD. Additionally, it would be interesting to see how many PODs fall in a different QQ
than described in the water right data. With those estimates in hand, it could be possible
to get an idea of the time required and legal challenges to overcome if IDWR decided to
move PODs to the most accurate position available, and if those legal efforts would be
worthwhile.

Some respondents stated that the current system works for them, and it is not a major
problem that some POD'’s are not in the exact location. One respondent added that, if a
water right is not in exactly the correct location, it will not take much research to find its
correct location. In most cases, the POD is near the border of the correct QQ, and
typically the correct location can be found by cross-referencing the water rights database
with other databases, such as the wells database or aerial imagery. Multiple
respondents stated that having an accurate location for a POD is important and
necessary for many business processes.

8. Can IDWR improve how it collects and stores POD data?

Most respondents agreed that IDWR could, and already is, improving the collection of
new spatial data. Proposed points of diversion are GPS-ed, and IDWR staff uses a
variety of imagery, taxlot data, and USGS topographic maps to help verify the location of
a POD.

One respondent mentioned he is particularly interested in how PODs are spatially
related to each other, and also interested in the prospect of tying them to the NHD. The
ability to trace upstream or downstream and display the order of the PODs would be a
beneficial addition to some of his workflow applications.

Another respondent would like to see consistent names for wells that appear in multiple
IDWR databases. For example, this person would like to link multiple databases and
display a POD layer showing all pumping rates and water right priority dates. One
respondent added that incorporating the Underground Injection Wells (UIC) to the
SpatialData Layer, and, ultimately into the Enterprise Database, would be beneficial.

Two respondents said that it would be really helpful if there was a canal name
associated with a POD which could be stored in the “DiversionName” attribute field. This





is especially true when two canals divert water in opposite directions from the same
location in a natural stream. Entering the DiversionName was not on the SRBA forms
used to enter this data, but names were often entered into the “Remarks” field, although
there are many records where this information is missing.

It would also be helpful if more PODs had a description in their “DiversionWorks”
attribute field that would store a description of the pump or gate associated with the
POD.

IDWR is working hard to ensure that PODs in the same spatial location also appear in
the same location in the database. Currently, many PODs are still scattered which can
make it difficult for the database user to determine which point represents the correct
location.

One respondent would like to see a stand-alone interface for entering POD data that did
not require opening the entire ArcMap application. interface.

One respondent would like a simplified approach to query the enterprise POD database
and select all “PODs that are not groundwater”.

9. Water Banks

Water banks are used to temporarily re-distribute water. There are two main
components:

(1) Water banking, using “supply pools” for the purpose of maintaining minimum stream
flows. This program is directed by the Idaho Water Resource Board.and is not part of the
enterprise POD database. This information is stored and maintained in an Access
database, consisting of very basic water right information.

(2) Local Storage, also referred to as “rental pools”. This can be managed by the district
watermasters, with the approval of the IDWR Director.

The challenge with this type of data is that it is temporary and interacts with the
enterprise POD database. For example, water appropriated by a water right belonging to
Joe is used in 2009 by Jill. Since this situation is only temporary, it should not be
changed in the Enterprise database. One respondent would like the capability of being
able to query a water right to find out who is using the water or if it is available. Ifitis
available, perhaps it can be leased to another water user

10. Symbolization

IDWR does not use standard symbology for PODs with most respondents using the
symbology set by WREdit. One person complained that the colors are not well chosen
for people that are color blind.

Most respondents agreed that it would not hurt to standardize POD symbolization across
the entire IDWR agency but all stated that this would be a low priority project. One stated
that standardized symbolization should be not too rigid, since, depending on background
layers and colors one symbolization scheme would work better than another. Also, the





symbolization of a specific point feature may be different from one map to the next
based on the purpose of a map.

One respondent added that we should follow USGS Topographic Map conventions
where they exist. Ultimately, it does not matter very much as long as there is a clear
legend that explains the symbolization.
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Referencing Water Right PODs in the Payette Subbasin to the NHD

using the Hydro Event Management (HEM) Tools (v 2.2).
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SETUP

1. Install HEM Tools (\\HEM Tool Training\HEM (v2.2).

2. Start ArcCatalog.
3. Add the HEM Toolbar to ArcCatalog (View -> Toolbars -> Hydro Event Management Tools).

]
I_==_|§§Z.E_I,,,.ﬁ.l:u:uut

4. Create new empty personal geodatabase on your hard drive and call it POD_HEM_EVENTS (or
you can pick a different name)

5. Single click the POD_HEM_EVENTS personal geodatabase you just created in the table of

contents, and then click the Event Featureclass Manager button =] on the HEM Toolbar.
Note: Dialog will be blank

6. Using the Event Featureclass Manager (Tools -> Add New), create an events feature class. Name
it. The rest of the settings should be similar to the dialog below. Click “Create New”.

Event Table Manager

Tools

Featureclass Name

POD_Point_Events

Geometry Type * Point " Line " Area
Schema Type * Ful " Only Reguired Fields
Mulbi-Raute Event r
Default Reach Resolution " Local  © Medium % High
Caontinuous Event r
EventType Domain Mone -
Configuration Keyword | J

7. Set the spatial reference
a. This will open the spatial reference dialog box.
b. Import the coordinate system of the NHD Flowline. The coordinate system should
match the system of the layer/network you are referencing to. Next through the
defaults (2 next, 1 finish).
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8. Close the Event Table Manager

9. Refresh (F5 or View>Refresh) and look at what you just created:
-] DaTa A

-3

+ Payette_IDTM.mdb

-5 POD_HEM_EVENTS.mdb
HEM_EVEMT_TABLES
HEMFeatureToMetadata
HEMMetadata
HEMMetadatalls
HEMSourceCitation
=] PoD_Point_Events Z

10. Close ArcCatalog
11. Start ArcMap and load the Hydro Event Manager toolbar. (View>Toolbars)
12. Add Data
a. The Entire NHD Database.
Note that the NHD database must have a geometric network.
When adding the NHD Database, you may see the dialog box

WErming; all

& selected item could not be added to the map
Item nok Found in this callection,

Say OK
b. Point Data you wish to reference to the NHD.
c. The Events feature class and tables you just created.

13. Click to the Display tab in the Table of Contents. Turn off and group NHD layers that are not
helpful with referencing. (Usually, the layers that are useful are the NHD flowline and the

Hydro_Net_Junction layers.)

14. Adjust the symbology of the layers added.
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15. Label the NHD Flowline with the GNIS name. Label the Point Data with attributes that can help

you reference it.

* Untitlad - ArcMap - Arclnfe

Blo Edt Yew Eockmorks [roert Sekection Took Window Hep WD
TestRCA B hsson Feach Code (OO0 Frocessng Ltities v Heln

= & s
ATl

DEHS B>

.JM'

& Layers
i 0\l DskalLISGS Propossl POD_Eve
=

@
3 oiwima_Duatailises_Propossl FOD_Eve
Bl PoD_Print_Events
@
I reMsourceCstion
I rEMMetadatalDs
0 HeMMetadata
T HEMFeatureToMetadats
T HEM EVENT TRBLES
[ ceiwima_DutailISGs_Propossl_FOD_Eve
W tyrograchy
B norowine

H ¥ C)

whieEOXr LEIRO S

au

~.

N 7

N

< > . N
ity Souace [Selecion LR 1
wog x| b | [ ] [ =X @@

2 | e v Kk

) 2
2 0= A= = |[olaie vmvn!l.ll

AR E) 1421340, 71 Maters.

16. You are able to transfer one attribute from the data point shapefile to the event database.
a. Open the point shapefile attribute table
b. Options>Add Field
c. Name the field DSCODE, Text, length:2

d. Populate this field with a two-digit code for each collection source, as follows:

Digitized Dz
GPS GP
Section SE
Q Q1
Qa Q2
QaqQ Q3
Blank XX

e. Create another field called “HEMCODE”

f. Options>Add Field
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g. Name the field HEMCODE, Text, length: 40

h. Calculate the HEMCODE field with a unique identifier. Concatenate the IDWR spatial
data ID, POD Source, and the newly created field, DSCODE:

Calculation: [sp_data_id] &" " & [Source] &" " & [DSCode]
i.e., “00001_PAYETTE RIVER_DZ”

i. Close the attribute table

17. On the Editor toolbar, Editor > Start Editing. Select the Personal Geodatabase that contains the
Event tables you set up earlier in ArcCatalog.

18. The Select Metadata Session dialog box may appear. If it doesn’t, on the HEM Toolbar > Edit
Tools > Metadata > Start Session

Hydro Event Management Tools 3]

Lt Task ICreate Point Event vI Target: IPOD_Point_Euents "I Edit Tools * Help

efadata Sessio L]

e [u] | Doy | ProcessDescrip... | ProcessDate | Attributefccura. .. | LogicalConsiste. .. | Completeness... | HorizPoszitio

»

4

19. Click on Create Button
20. Type in metadata information:
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f® Create Metadata Session

. Process Description  Other

Process Description Ince POD from IDVWR databasze to NHD Sftribute Accuracy Report

Contact Instructions Call between 5:00 and 1:00 P

|
Process Date I DSIEiDat; whenlthe process was completed, Fori I
—Cantact Information Complsteness Report [
Contact Organization | VR Horizontal Postional Accuracy |
Address Type I Physical and hailing “Yertical Postional Accuracy I
Address I 322 E. Front Street Metadata Standard MName I
City | Buoize Metadata Standard Yersion I
State or Province I D letadsta Date I 0503201 0
Postal Code | 53770 Dataset Credit [
Contact Telephaone I (208) 267 -4530 New DuulD: -1
|
|

Contact Email GlS @i idaho.gowv

Tip: Use CHI-E to open text editar for long text values.

T Source Citation

Q| Title SourceCitationdbkn Criginstar PuklicationDate BeginningDate EndingCrate Sourc

Create Source Citation m
Create Metadata Session

21. Click Create Metadata Session.
¥ 5ol stadata Sessio =

o[} | LD | ProcessDescrip... | ProcessDate | Aftributetccura... | LogicalConsiste... | CompletenessR.. | HarizPositio

22. Make sure the Metadata session you selected is highlighted. Click Select.

23. You are now ready to start creating Events!!
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CREATING POINT EVENTS FROM A POINT FILE

NOTE: If your ArcMap project, Point Events database, and metadata have already been set up;
Open ArcMap, Editor toolbar, Editor > Start Editing. Make sure your HEM toolbar Target is the
Point Events layer. HEM Toolbar > Edit Tools > Metadata > Start Session. Highlight the existing
Metadata record, & click “Select”.

=
8 Sele etadata Sessio L]

QD | DuulD Meta_ProcessiD rocessDescrip... | ProcessDate Attributeccurs.. | LogicalConsiste. . | CompletenessR .. | HorizPo:

4 4

1. Onthe HEM toolbar, set Task to Create Point Event and the Target to Point_Events:

Hydro Event Management Tools

k* ! Tazk: ICreate Peint Event j Target: IPDD_Poim_Euems j Edit Tools = Help

2. Go to Selection > Options (on main menu near the top of your screen) and set Selection
Tolerance. Set this value to 10 pixels. Click OK. You do not need to change this value during
different iterations.

7|Page Payette POD HEM Documentation





Selection Options

Interactive selection
R R N
wWhen vou select Features by dragging a biox with the Select Features

tool or Edit tool, or by using the Select By Graphics command, how do
wou want Features to be selected?

{* Seleck Features partially or completely within the box or graphicis)
™ Select Features completely within the bowx or graphicis)
(" Select Features that the box or graphic(s) are completely within

[v Clear the selection Far invisible layers when a new selection is made

Selection tolerance: | 100 pixels [éﬁ B » O F

Selection Colar

Choose the color wou want selected Features to be shown with by
default:

Warning Threshold

[v Display a warning when performing a 'Select All' or 'Switch Selection’
if the number of records is greater than this threshold:

Record Count = | 2000

[v Save layers with their current selections

(a4 | Zancel

3. On the Editor Toolbar, go to Editor > Options. Set Selection Tolerance to 10 pixels on the
General tab. Click OK. You do not need to change this value during different iterations.
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Editing Options

General lTopo\ogyl Versinning} Units ] Ed\tTasksl Annotalinnl Atlnbutes]

Display measurements using 3 decimal places
Snapping kolerance: | 10 ‘pixels ﬂ
Sticky move talerance: 0 pixels

[ Stretch geometry proportionately when moving a vertesx
[ Show snap tips
Stream Mode

Stream tolerance: 0 map units

Group 50 points together when streaming

oK. | Cancel Apply

4. Set the Snapping Environment
a. Editor toolbar, Editor > Snapping

b. Make sure that Vertex, Edge, and End are checked for NHD Flowline.

L4 x
Layer Wertex Edge End
mergel O O O
MHDPaink O O
HYDRO_MET _Junckic ] O O

[] [] []

O O O
NHDArea O O O
Subbasin O O O
Basin O O O
Region O O O
Subregion O O O
Subwatershed O O O
Watershed O O O
=[] Edit Sketch

[ Edit sketch vertices

[] Edit sketch edges

[] Perpendicular to sketch
=I-[] Topology Elements

[ Topology nodes
=[] Miscellaneous

[ survey Paints

Close the snapping environment

5. Inthe table of contents click once on the Import point Shapefile to highlight it (these are the
points that will be imported into the POD_POINT_EVENTS geodatabase).

6. Set the scale of your map; zoom out to a little larger than the full extent of your import dataset,
usually the subbasin boundary.
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7. Onthe HEM toolbar, click Edit Tools > Options. Click the Route Location Options tab and

populate as follows:

£l HEM Options (=]

Options

—Route Location Candidate Options
© Explicit

[ Only List Junctions (End Paoirts)
" Only List Mearest Point on Edges

[y Suppress the Candidate Form

—Route Location Default Suppr ion Method
ot

" Use Top of the Dovwnstream first, then uze Closest Candidate

¢ Use Closest Candidate first, then use Top of the Downstream

—Round Events
Events within tvwo measures of an endpoint will be rounded to the endpaint.

Ot

 on (events 0-2 will ke rounded to 0, 95-100 will be rounded to 100)

/ Apply and Close Reset to Defaults

8. On the HEM toolbar, click Edit Tools > Import Points

e L \

Hydro Event Management Tools

St mp @y kY @ Task Create Point Event VI Target:  |POD_Point_Events ~ | |Edit Tools = abao

\(\K\ \ KD} ¥ Clear HEM Elements

t- Snap Environmenk

\ >\ w F Select by Selected
nJ B Interactive Synchronize Events

. Batch Synchronize Events
@ Batch Synchronize Qa/QC

%

}8 Check Continuous Events
] Repair Continuous Events
/ ﬂ Impart Poinks

g Import Lines

f§ Import Areas

g Import Selected Flowlines

% Toqgle SourceFeaturelD

Metadata 4

Options
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9. If no features were selected in the Data Point Shapefile, you will see this dialog box:

HEM: Import Points

Mo selected Features For laver: Point_shapefile. Do wou want to import all poinks Fram this layer?

[}

10. Check to make sure that the layer is your original source points. If working in iterations, all
points should only be imported on the first iteration. On additional iterations, use a selections
unless the first iteration failed to import any points. Click Yes if first iteration.

11. Transfer the unique attributes from your Data Points Shapefile to the Point_Events Database:

Transfer IDs: Select Link Fields

Transfer IDs to Event Festureclass

Zelect Field to Calculste 1Dz From:
HEMCODE j

Zelect Field to Calculste 1Dz Into:;

[

Add ID's Don't Add IDs Stop Import

12. Click “Add ID’s”.
13. The program will run.

14. If more than one NHD feature should fall within the search tolerance of a point, a dialog box will
appear. If this dialog box appears, select the top record and say “OK” (see step 5).
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Select Route Location
Select a Candidate:

Mare than one feature is within the search tolerance.
Pleaze =zelect which gecometry wou waould like the input
paint ta =nap ta.

T end of Reachcode = 17050122001 415 ComiD = 52251078
Mearest point on Reachcode = 17050122001 415 ComlD = 52251078
T end of Reachcode = 170301 22006275 ComiD = -505

Mearest paint on Reachcode = 170501 22005275 ComiD = -505
FROM end of Reachcode = 17050122000574 ComliD = 52249054
Mearest point on Reachcode = 170501 22000374 ComlD = 52249054
FROM end of Reachcode = 170501 22006275 ComlD = -506

T end of Reachcode = 170301 22006275 ComiD = -506

Mearest paint on Reachcode = 170501 22006275 ComiD = -506

n Zoom to Feature Flash Feature

15. Select the top record and say OK. Do not Zoom to Feature.

16. A report will be generated showing how many point features have successfully been
transformed into events.

HEM: Import Points

:mport Paoints Results A

Fratn Festurelayer: POD_Sample_Data
To Festureclass; POD_Point_Events

Successiully imported: 3

Failed to import: 39
Frotm CICx:
Froem CICx:
Fram CiC:
Froem CICx:
Fram CiC:
Frown il

LI S R |

Save Report to File

17. When finished. Editor Toolbar, Editor > Save edits. Stop Editing.
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Test Study: Creating Events for the Emmett and Letha Irrigation Districts

1. Introduction

A subset section of the Payette Subbasin was used as an initial test area in order to assess the best
method by which to place point events along the NHDFlowline feature class. IDWR Water Right POD
locational points were used that fell within and around the Letha and Emmett Irrigation District
boundaries because updated linework has been completed in the majority of these areas. Each event
point that was placed along the NHDFlowline was individually verified to assess where it was placed, and
if there were any additional criteria that should be set before doing the entire analysis. It was also
determined that event points within this area could be verified by the local irrigation districts and/or
water experts for accuracy, which will help to identify future needs for refinement of the procedures
used in this study.

2. Source Data

Two hundred and twelve points of diversion (POD’s) were initially identified in this test study area.
These points were taken from the IDWR active water rights where point of diversion stream names were
known and populated in the source field of the attribute table.

Figure 1 — IDWR Points of Diversion (POD) from the Water Rights Database with named streams as Source





3. _Process:

Step 1: Projection

IDWR data is in Idaho Transverse Mercator Projection and the NHD data is in an Albers projection. The
shapefile of the 212 PODs was projected into the Albers projection to avoid any conflicts, as it is critical
that all projections match before creating events using the HEM Tools.

Step 2: Attribute Assignment

POD data is collected when somebody applies for, or transfers a water right. Historically, the locations
of those diversions were identified by the quarter-quarter (QQ) in which they are located. Given the age
of many water rights, and the spatial data available at the time those water rights were recorded, many
of the POD’s have been placed in the center of the QQ, which may or may not coincide with a stream or
other natural source described in the water right. Some locations have been digitized on paper or digital
maps, and some points are GPS. In order to check the potential locational accuracy of each point, the
method of collection for each location was preserved in the attribute field. A separate text field (text, 2)
was created in the shapefile attribute table, called DSCODE, and populated with a two-digit code, as
follows:

DataSource DSCODE

Digitized Dz
GPS GP
Section SE
Q Q1
Qa Q2
QaqQ Q3
Blank XX

A separate text field (TEXT, 40) was created in the table called HEMCODE.

A calculation was performed to concatenate the IDWR spatial data ID, POD Source (the Stream Name
being diverted from), and Data Source (how was the point derived - GPS? Digitized?).

Calculation: [sp_data_id] &"_" & [Source] &"_" & [DSCode]
Add an attribute field for the N, Y, U stuff.
Step 3: Dissolve

The shapefile was then dissolved on the HEMCODE field, to avoid multiple POD’s with the same source
(stream) at the same location.

TOOLBOX — Data Management Tools — Generalization — Dissolve





* Dissolve

Input Features
‘ ActiveRNamedSurface_TestSet j j
Output Feature Class
‘ DilA_MWHD_Maintenance\00_In_Progress\Payette HEM\TEST_Payvetteltest.shp
Dissolve_Field(s) (optional)
OF 9
[ waterRight
O sasinfumbe
D Sequencehu
O splitsufFi
D Status
D Basis
D PricityDa
<l_l Nererednak

¥

&

Select Al Unselect Al
Statistics Field{s) {optional)

Field Statistic Type

CHENESE YT L T

4

P

IV Create multipart features (optional)

™ Unsplit lines [optional]

(sl | Cancel | Environments. .. ShowHaIp >>

Figure 2 — Data is dissolved, using this dialog box

E Attributes of ActiveWRNamedSurface_Dissolved_TestSet?

| FID | Shape* | HEMCODE2 | ~
¥ Ofmuttipoint  |18846_PAYETTE RIVER_DI
1 Muttipoint | 19579_GRAVEY ARD GULCH WASTEWAY _DI
2 |Muttipoint | 19882_GRAVEYARD GULCH WASTEWAY Q2
3 Muttipoint | 19882_PAYETTE RIVER_G2
4 Muttipoint | 20071_MAIN DRAIN DISTRICT NO 1 _G:2
5
B
7
5

hultipoint 20086_GRAVEY ARD GULCHWASTEMSY _DE
hultipoint 20232_GRAVEY ARD GULCHWASTENMSY _GI2
hultipoint 20330_PAYETTE RIWER_Gi2
hultipoint 20420_GRAVEY ARD GULCHWASTENMSY _DE
9 | Muttipoint 21414_PAYETTE RIWER_DZ
10 | Multipoint 22145_PAYETTE RIWER_DZ

|11 | Mulipoird 22329_LATERAL B DRAIN, DIST. MO, ONE_G12 3

[ P TRy AETEST PR TTE ML e s

dRﬂe-:Dru:I: ﬂjl 1 jﬂ Show: W Selecked Records {0 out of 109 Selected) j

Figure 3 - Resulting table, after the dissolve

Step 4: Explode

As a result of the dissolve process, the shapes created were “multipart” feature points. An additional
step was required to “explode” those points, separating them as individual spatial points, thus avoiding





any errors while running the HEM tools. In this case, there were multipart features within this dataset,
bringing the total records from 105 to 111.

-Editor — Start Editing — (select feature class), rt. Click on feature class — Selection — Select All

Advanced Editing Toolbar — click the “explode multipart feature” icon

Advyanced Editing

Figure 4 — Advanced Editing Tools — “Explode” icon

Step 5: Use the HEM Tools to Create Events

The Hydro Event Management Tools (ver. 2.2) were used to create events from the dissolved and

exploded dataset. The process of creating events from points using the HEM Tools (ver 2.2) has been
summarized in Appendix A.

The HEM tools successfully imported 105 out of 111 points. Six points did not import, and resulted in
error messages (see Appendix B—HEM Tools Error Report).

HEM: Import Points @

Import Poirts Resutts

From Featurelayer: ActiveWwRNamedSurface_Dizzalved_TestSet2 ALB
Tao Featureclass: POD_Paoint_Ewvents
Impart Method: Geametry from Trace Results.

Successfully imported: 105

Failed to impoart: 6
From QI0: &0
Fromm QI 99
From QID: 104
From QID: 105
From CID; 108
From CID; 108

Save Report to File

Figure 5 — Dialog Box showing HEM Tool import results

4. Results:



http://nhd.usgs.gov/tools.html



Each new imported event was spatially checked and verified to determine accuracy. Records that were
determined to be incorrect were given a “N” attribute. Records that were verified to be correct were
given a “Y” attribute. The remaining records were given a “U” attribute for Unknown; these events
could not be verified due to various factors described in the “Unknown Events” section of this report.

Collection Method Number Correct — Y/N/U
Digitized 16 Y
26 u
1 N
GPS 11 Y
Nominal (QQ, QQQ) 12 Y
28 u
9 N
Unknown (Blank) 1 Y
1 U
TOTALS 105

Figure 4 — Table showing Collection methods and verification results

Incorrect Event Points: Ten event points of 105 snapped to the wrong location. Of these, nine were

nominal quarter-quarter (QQ) locations, and one point was digitized. In all cases, these were
determined to be errors after being individually verified that they snapped to the wrong stream. These
were checked by comparing the stream names in the event table with the NHD Flowline GNIS name
attributes. In the example shown below (figure 6), the original POD was located in the centroid of the
QQ section, and snapped to the closest stream, which was an unnamed stream.





HEM Tools put the event here -
via "closest stream” selection

i

This is the correct Stream - Bissell Creek |

Ol

Figure 6 — QQ nominal point is snapped to the incorrect location

In the case of the digitized point, it snapped to the wrong stream name, and additional authentication
would be needed to verify the canal names and locations. In this particular instance, the point snapped
to the “Last Chance Canal”, and the IDWR database referenced “Tunnel No. 7 Wasteway” as the POD
source (Figure 7). This is an example that further corroboration would be needed to investigate whether
this event point did, indeed, snap to the wrong canal, or if it was simply a GNIS naming error. Itis
possible that this point was digitized incorrectly on the map, named incorrectly in the database, or that
“Last Chance Canal” and “Tunnel No. 7 Wasteway” are the same canal, but known by different local
names, which would make this a correct match. Additional work may be necessary to update the NHD
Flowline and GNIS canal names, depending on the findings.





Is this section part of the same system?

Figure 7 — Does this canal system connect? Is it the same canal but named differently?

Correct Event Points: Forty event points of 105 (38%) snapped to the correct stream, verified by
performing a spatial intersect of the event points and the NHD flowline, then comparing the stream
name attributes. Areas that contained GNIS name matches were considered correct without further
investigation. Twelve events were QQ's, 16 events were digitized, and 11 events were GPS. One event
was blank (no stream source was identified in the Water Rights database), but was verified and marked
“Y” (matched) by looking at the aerial photography and determining that the Payette River was the only
feature in that QQ, therefore, the only hydrography feature that an event could snap to (figure 8).






R —“«

Figure 8 — Snapping to the only stream in the QQ

It was also noted that there were events that snapped to the correct location only because there were
no other features within the snapping radius. As irrigation companies update their line work and new
canal features are added to the NHD, the areas that are populated with historic QQ nominal points may
have a greater probability of error in those areas (figures 9a & 9b).





o
HEM Tools put the event here - r" -
via "closest stream” selection, | '}

HEM Tools put the event here -
via "closest stream” selection,
which is the correct location [

Figure 9b — Using this method, the point event would snap to the closest location, not the correct location as additional canals
are digitized into the NHD.





Unknown Event Points: Fifty-five point events of 105 (52%) snapped to a location that could not be

definitively verified. Of these, 28 were nominal quarter-quarter (QQ) locations, 26 were digitized points,
and there was one additional point with a blank field for POD source from the IDWR database. All of
these POD’s had source names that differed from the GNIS_Name features in the NHDFlowline table. A
closer look at some of these points revealed that they probably were matches, but additional work
would need to be performed to check the POD source data against supplementary data supplied by the
irrigation districts.

There were some instances of braided streams of the Payette River where the events did not snap
directly to the Payette River, but to the river braid. In the example below (Figure 10), this point was
coded as “unknown”, as the braid portion of the river is not a named feature, causing a “non-match”
between the NHD attributes and the IDWR database attributes. Upon further inspection, it was
discovered that the original point was a nominal QQ, (placed in the center of the QQ section), so it was
unclear where the diversion point was; directly out of the Payette River (from the braid?), or from a
tributary stream. Had this point been derived from either a GPS or digitized point, it would have been
interpreted as a match, after manual inspection.

~— [l
Snapped to the closest hydro -
Payette River braid

Figure 10 — Example of an unnamed braided stream in the Payette River

There were also two instances of injection and re-diversion sites. This occurs when water is diverted out
of one location, injected into another location, and re-diverted into yet another location. These events





are three separate points of diversion records in the IDWR database, but with the same POD source
(usually the original POD). In these cases, the hydro names will match for only one source, the original
diversion (see Figure 11). Further investigation and cooperation with local agencies would need to be
done to definitively match these sites to the proper diversion points. It was also noted that a separate
procedure needs to be worked out when querying the IDWR database to avoid having to manually check
each of these records throughout the state.

Code- Incorrect
braid of the Payette River §
Stream Names don't match

/ Water goes from point A G S \ - I \h\_\ '
Injected to point B al Yo/
Rediverted to point C ; By

" Code - Incorrect -
braid of the Payette River ¥
Stream Names don't match

— s

Figure 11 — Example of an Injection and Re-diversion site

The majority of the event points were coded “unknown” simply because the event point snapped to an
unnamed stream or canal. Because these NHDFlowline features were did not have names associated
with the GNIS_Name field, it was impossible to do a cross-check of named features between the IDWR
Water Rights database and NHDFlowline feature class. As work persists with local agencies, name
revisions and additions will continue to be added to the NHD, thus providing more opportunity for event
matches and further assessments in the future.

5. Discussion:

Overall, 50 event points (48%) were determined to be either correct or incorrect, using the HEM Tool
Create Points methodology, while the other 55 points (52%) were defined as “unknown” and required
additional assessment. The Suppress Route Candidate option was used to avoid having to manually





select a route candidate, especially for the nominal QQ points where the exact location is not defined,
nor known by the GIS staff performing the analysis. An assessment of whether or not the point snapped
to a named stream (in cases where the POD name was present) was the first step in determining
whether or not further investigation was warranted. Additional review was conducted to determine
how the point was originally collected, i.e., QQ, GPS, or digitized. Events that matched stream names
(NHDFlowline and original POD source) that were digitized or GPS were considered correct with no
further review, while events that were derived from nominal QQ events may warrant further review to
correctly place them along the network in the future.

Several issues arose while using the HEM Tools to create point events. More information can be found
in Appendix B “HEM Tools Error Report”. There were 6 points that did not import using the HEM tools.
A separate process was performed with these points using the ArcMap Locate Features Along Routes
Tool, with success. It was noted that point events created with the Locate Features Along Routes Tool
maintain the attributes from the original point dataset and will maintain one field from the geometric
network. This is nearly opposite of the HEM tools which maintain all of the attributes from the
geometric network needed to populate the NHDPointEventFC but only one attribute from the original
point dataset. Another advantage of the HEM tool is that it creates a point featureclass. A point
featureclass must be generated from the tables using Add Event Theme created by the Locate Features
Along Routes Tool.

The procedure implemented by IDWR was that the maps cale should be set at least equal to the extent
of the subbasin before beginning to import points. This eliminated any dependence on pixel size and
the resulting potential effect on the number of route candidates being adjusted.

6. Conclusion:

IDWR successfully used the HEM Tools version 2.2 to create point events for 105 of 111 points (95%)
originating from the IDWR Active Water Rights database; populating the Source_FeaturelD field with a
concatenated attribute consisting of the spatial data id, POD hydrography source, and point collection
method. The HEM Tools provide a valuable resource for creating and managing spatial event data along
the NHD network, while maintaining all of the attributes necessary to utilize the geometric network of
the NHD data model (v2.0). By using this method, IDWR was able to define the data elements required
to spatially distinguish which events needed further investigation and construct a workable method by
which to accomplish this task.

It should be noted that IDWR has received additional canal updates from local irrigation companies and
cooperators in this area, and plans are currently underway to further update the NHD in the Payette
Subbasin.
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Figure 12 — POD Collection Methods for the 105 event points created with the HEM Tools

Appendix:
A. Referencing Water Right PODs in the Payette Subbasin to the NHD using the HEM Tools
**put weblink here **
B. Error Report — Referencing Water Right PODs in the Payette Subbasin
** put weblink here **
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HEM Tools Error Report — Payette Subbasin Issues

There were 11 points that did not import using the HEM tools. The following message was displayed:

HEM Error, §|

Message --- Objeck reference nok set to an instance of an object,
! Time: 92312010 11:14:14 AM

For detail error information see;
My DocumentsiHEMYHEMErrorLog, bxk

These points were used as input for the Locate Features Along Routes Tool (Linear Referencing Tools in
ArcGlIS), and they were successfully imported using a 300-meter buffer to the nearest feature. Itis
unknown what conditions caused these points not to import using the HEM tools.

It should be noted that point events created with the Locate Features Along Routes Tool maintain the
attributes from the original point dataset and will maintain one field from the geometric network. This
is nearly opposite of the HEM tools which maintain all of the attributes from the geometric network
needed to populate the NHDPointEventFC but only one attribute from the original point dataset. An
advantage of the HEM tool is that it creates a point featureclass. A point featureclass must be
generated from the tables using Add Event Theme created by the Locate Features Along Routes Tool.

Using the ArcGIS Locate Features Along Routes tool appears to be as effective in placing a point on the
correct canal and lateral system as the current HEM tool methodology if no candidates are reviewed.
Additionally, the ArcGIS tool works on a selection set of the flowline data. Much of the point of
diversion data contains some type of source information that could be used to filter the potential
flowlines the points should be linked as events on. It would be useful if the HEM tool would do the
same; hence narrowing the possible candidates.

Specific Below is a summary of the issues that were observed during this study:

1) There were 11 points that would not import (Message—Object reference not set to an
instance of an object), prompting the user to hit “OK” through each instance of the
message. After a time, the screen would “lock” graphically, and a refresh would not work.
Zooming and panning would leave graphics on the screen from the previous extent. At the
end of the session, it was necessary to exit ArcMap to clear the accumulated graphics.
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Example of graphic “freezing” on the screen after running the HEM Tools

2)

Although the “Suppress Candidate Form” option was turned on, there were a few instances
that the “Select Route Location” form came up with the message “more than one feature is
within the search tolerance, please select which geometry you would like the input point to
snap to”, prompting the user to choose an option and press “OK”. In all instances, the 1%
option was selected.

[® Select Route Location

Select a Candidate:

hare than one feature is within the search tolerance.
Pleaze select which geometry you would like the input
point to =nap to.

TC end of Reachoode = 17050122008136 Permanent_ldentifier = {03C55709-CA1C-4345-9817-BEABCBE2D941 }

Mearest point on

“ Zoom to Feature Flash Feature

Reachcode = 17050122006186 Permanent_ldentifier = {03C55709-C41C-4345-9817-BEA3CEEZD941 }

Example — “Select Route Location” dialog box with “Suppress Route Candidtate” feature on.





3)

4)

5)

This could be a time factor in cases where large datasets are being imported.

If projection of Data Frame does not EXACTLY (name and parameters) match the projection
of the network, an error will be displayed every time more than one route candidate exists
(HRESULT:0x80040215). This can result in a lot of time wasted pressing the OK button
before application is released, if the Suppress Candidate form is not turned on. A
programmatic comparison of the data layer projection and the network projection before
creating the first event could be useful.
Tool will import points from event feature class into itself. This creates a multitude of
errors. A programmatic error trap is needed if the Target of the HEM Tools equals the
feature layer being imported.

Snapping Tolerance (Editor|Options) appears to have no affect on tool performance.
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1. Introduction

Water, a scarce resource in ldaho and through the Western U.S., is important to many competing water
users including the agricultural, urban, recreational, and fisheries sectors. Being able to view all
diversions, including irrigation, fish propagation and gage diversions, addressed to the same route
(waterway) and in the correct sequence, will provide an unprecedented opportunity to compare and
model competing water uses. This ability will considerably improve the ldaho Department of Water
Resources’ insight into water delivery and water use.

Idaho Department of Water Resources (IDWR) has a database containing information about IDWR Water
Right Point of Diversions (POD’s). Some water rights are nominally located based on the Public Land
Survey (PLS). In general, the water rights spatial location represents the legal location and in some cases
is geographically removed from the corresponding stream. The geographic representation of diversions in
the IDWR Water Rights database cannot be easily adjusted due to legal restrictions. Idaho has tens of
thousands of surface water diversions within the state. Representing Points of Diversion (POD) as events
tied to the National Hydrography Database (NHD) that can be adjusted to a better location along the
stream, rather than as points is the best way to represent relationships among various diversions. Adding
these diversions as events would allow IDWR to store, query, and analyze this information along the
hydrographic network without altering the legal location.

Water managers rely on accurate hydrographic data for planning, modeling and other tasks. Many local
managers have diverse information about their organization that need to be tied to their hydrological
system in order to facilitate planning and system management. The National Hydrography Database
(NHD) is a nationwide dataset containing hydrologic features such as streams, canals, lakes, ponds and
swamps. The NHD is currently the Idaho state framework database for hydrography, and is used by the
major federal land managers as well. The NHD is also a geometric network and an excellent platform for
data exchange of water information. Currently, in Idaho, the NHD is available at a medium resolution
(1:100,000) and high resolution (1:24,000).

Given the large amount of work this State has done adjudicating water rights in the past 20 years, a
dataset of water rights tied to hydrography will benefit water accounting, and water use modeling of
Idaho’s waterways. IDWR will use the Payette subbasin, 17050122, in this pilot project.

2. IDWR Point of Diversion Survey

During September 2009, a variety of IDWR personnel involved in creating, maintaining and using POD
information were interviewed to assess their views on what constitutes a POD, how PODs should be
collected and stored, how useful the POD information is for them, and how this representation of POD’s
can be improved. Twelve participants within IDWR were initially interviewed and asked to fill out a
guestionnaire consisting of 10 questions. Diagrams were also included within the survey to gather each
participant’s interpretation of where the point of diversion should be located in three different scenarios.
After each participant had completed the survey, interviews lasting approximately 1-2 hours were then
conducted with each person to discuss their answers and gather additional information from them
regarding PODs. The results of those interviews can be found in Appendix A.
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2.1 What s a point of diversion?

The right to divert and appropriate the unappropriated waters of any natural stream to beneficial use is a
right granted to all Idahoans as per Section 3 of Article 15 of the Idaho Constitution. The Idaho Code
states, “All the waters of the state, when flowing in their natural channels, including the waters of all
natural springs and lakes within the boundaries of the state are declared to be the property of the state,
whose duty it shall be to supervise their appropriation and allotment to those diverting the same there
from for any beneficial purpose (..)” §1.C. 42-101. Based on these descriptions, a point of diversion (POD)
is often defined as “the location water is diverted from its natural_source” by many IDWR business
processes and for this project.

frrigation District -----+

Point of Diversion

Matural Tributa

: Snhake River

Figure 2.1 — Example of a point of diversion

2.2 ldentify sources of PODs in IDWR databases

POD data is used and maintained by several different business processes at IDWR and sometimes in
separate databases. A component of the IDWR Point of Diversion Survey was to identify those databases
and which business processes used them. A summary of the results is shown in Table 2.1. Footnotes are
listed for each department that had additional information regarding the uses of these databases (Table
2.2).
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Table 2.1. Database use per discipline.
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Feature Dataset
SpatialData X X X X X
-Unique ID & spatial locations for features of interest to
IDWR business processes.
WMIS (Water Measurement Information System) X X X X X X X
- Annual volume data for primarily groundwater wells, incl.
some springs
*Water Rights — Application X X X X X X
*Water Rights — Permit X X X X X X
*Water Rights X X X X X X X
*Water Rights - Transfers X X X X X X
*Adjudication Claims X X X X X X X
*Adjudication Recommendations X X X X X X X
*Adjudication Transfers X X X X X X
Well Construction X X X X X X
Wells managed by the USGS X X
Wells data managed by S. Baker X X
Ground Water Monitoring Wells X X X
Geothermal Wells X X X
Wells in Public Water Supply Data X X X
Wells maintained by other agencies X X
Underground Injection Control Wells X X X
Gages maintained by the USGS X X X X
Dam Safety Database X X X
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Table 2.2: Footnotes for Table 2.1

*

IDWR Water Rights Databases:
Shapefiles for Water Rights (WR) were originally developed from GCDB QQ for Place of
Use (POU) or GCDB QQ/QQQ centroids for Points of Diversion (POD). If better
information is available, irrigation POU and PODs are screen-digitized from Aerial Photos
or GPS locations. WR can be in one or more of five process or stages; Application of new
WR or transfer, Permit (water use is allowed to develop), License (IDWR has approved
final configuration and amounts), Claim (WR has been claimed in an adjudication),
Recommendation (what IDWR recommends to the court. A recommendation, when
approved by the court, supercedes it’s License.

Water Modeling:
Water Modeling uses other information, such as gages maintained by Idaho Power. In
addition, IDWR measures sites and maintains in-house data regarding these sites, but this
data is not part of an agency-wide database. It is, however shared among a smaller
number of IDWR employees.

Planning:
The Planning group uses information maintained in the “SpatialData” dataset secondary to
project-specific data. For example, PODs in the area of interest are GPS’d and stored into
a local database. This data is not currently part of an agency-wide database. Planning also
uses other information, such as gages, maintained by Idaho Power and IDWR. The IDWR
gage data is not a part of an agency-wide database, but is shared among a smaller number
of IDWR employees.

Water Accounting:
The representative for Water Accounting was a programmer who builds water accounting
models. The models are used for billing and allocating water throughout a basin. .

Water Accounting also uses information regarding gages maintained by the Bureau of
Reclamation or by individual irrigation entities.

Floodplain:
Floodplain mapping and modeling does not currently use any of the IDWR listed
databases. They do use data that they collect themselves and data they receive from FEMA,
Bureau of Reclamation and Corps of Engineers. They also use gage data from the
Northwest River Forecast Center (http://www.nwrfc.noaa.gov/).

Adjudication/Water Rights:
Adjudication/Water Rights uses Groundwater Monitoring, Geothermal Wells, Idaho
Department of Agriculture, and Public Well Supply data maintained by the Idaho
Department of Environmental Quality. They also use data from the Bureau of
Reclamation, the Bureau of Land Management, the Idaho Department of Parks and
Recreation, and the IDWR Underground Injection Control Wells Database for the wells
that have been issued permits.
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Table 2.2 Continued

6  Water Rights:
Water Rights maintains a spreadsheet with temporary appropriations, for example, annual

renewals. Those appropriations are only meant to be valid for a limited time, for example
an appropriation for dust abatement during exploratory drilling.

Information about pumps and dams can be found in the description associated with a
water right but not directly in the Water Right Database.

7 Regulation and Water Measuring:
Additional gage information used by Regulation and Water Measuring include Eastern
Snake Plain Aquifer (ESPA) monitoring stations and those maintained by Idaho Power
and IDWR. There are plans to include the ESPA monitoring stations in the “SpatialData”
dataset in the future.

Regulation and Water Measuring sections within IDWR receive annual reports from Idaho
Power Company (IPCO) and other utilities in Idaho showing power consumption records
for irrigation wells. Based on this data how much water that has been pumped for
individual wells can be estimated and Power Consumption Coefficients (PCC’s) are
developed.

The Groundwater Monitoring and Geothermal Wells databases are in the process of being
linked to the Well Construction database. The goal is to coordinate and link information
between separate well databases and link them through identifiers within the Well
construction database and the “SpatialData” dataset.

Underground Injection Wells (UIC) information is not currently part of an agency-wide
database.

At the conclusion of the survey, it was determined that the POD information in the IDWR Water Right
Database would be used for this project.

For more specific information regarding individual databases and applications within IDWR, refer to
Appendix A.

2.3 Using PODs in the IDWR Water Right database

POD information for a water right is collected when IDWR receives an application for a water right or for
a transfer of an existing water right. Historically, the locations of those diversions were identified by the
guarter-quarter (QQ) in which they are located. A QQ has a surface area of 40 acres, and is one sixteenth
of a section within the PLS system. When only QQ data is available, a POD is placed in the center of the
QQ, which may or may not coincide with a stream or other natural source described in the water right.
(Figure 2.2)
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Figure 2.2 — Quarter quarters are one sixteenth of a section in the PLS system, nominal POD'’s are placed in the center of each QQ..

During the last 10 years, more work has been done to collect GPS locations for PODs, but the legal
description of the right can only be changed as a result of either a modification of the water right or an
administrative procedure changing the elements of the water right. Using GPS data has allowed IDWR
personnel to improve spatial accuracy for some of its points of diversion. However, since points of
diversion are legally tied to a given QQ, it is sometimes not possible — without the proper legal procedure
—to move a POD to the GPS’s location. Over time and depending on resources the locations that were
based on QQ locations or digitized will be replaced by GPS locations. Locations of diversions are collected
through the various “work flow” processes in place at IDWR and are put into the IDWR Water Right
Database.

3. Updating NHDFlowlines in the Payette Subbasin (17050122)

The Payette Subbasin, 17050122, was selected for this pilot project. The proximity of this subbasin to the
IDWR State office made it more efficient to perform field validations or to contact local agencies. In
addition, the Emmett and Letha Irrigation Districts both agreed to review their service areas on paper
maps (provided by IDWR) and submit revisions in an effort to add new canals or update existing canals
for inclusion into the NHD. Also, this subbasin has been recently adjudicated and IDWR has done
extensive work on water accounting in this subbasin. Revising the NHD linework to reflect the actual
irrigation systems in this area was an important prerequisite in order to accurately place the events.
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Figure 3.1. The Payette sub-basin is located in Western Idaho.

3.1 Collecting data to update the NHD
Collecting data to update the NHD was done in multiple steps:

1) Using aerial imagery from the National Agriculture Imagery Program (NAIP), existing NHD and
information from the IDWR Water Rights Database, a new hydrography layer with the best
available data was created.

2) The newly created hydrography was distributed to local agencies and stakeholders. IDWR
employees attended a local water meeting in Payette, Idaho and presented maps and asked for
input to verify those maps, and update where necessary. Stakeholder input was collected in two
different ways:

a. By handwritten notes on IDWR generated paper maps
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b. W.ith the use of ArcGIS. IDWR has developed specialized editing tools, and those are
available to districts interested updating their system digitally. More information on
these tools and their uses can be found at

The NHD was updated with the best available data collected in the previous two steps. There were
approximately 1190 NHDFlowlines out of 8400 that were either new or revised in the Payette subbasin;
the majority of those were contained within the Emmett or Letha Irrigation Districts.

4. Referencing Water Right PODs to the NHD

Points of diversion (POD) shapes in the IDWR database represent where water is diverted from live flow,
either surface water or ground water (i.e., springs, stream, or a well), to be put to beneficial use under a
water right. A water right must have at least one, and may have many, PODs. For each water right, any or
all PODs can serve any of all uses specified in the water right.

The Hydro Event Management (HEM) tools were developed by the Pacific Northwest Hydrography
Framework group ( ) with support from the United States Geological
Survey (USGS) and the United States Environmental Protection Agency (USEPA). These tools are
specifically designed to create and manage event data that is tied to the NHD.

This pilot project used the IDWR Water Rights Database in the Payette subbasin (described in section 4.1)
to create point events along NHDFlowlines utilizing the HEM Tools (ver 2.2). By placing events along the
NHD geometric network, water managers can share information about their system infrastructure
without adjusting local data. In addition, local managers can take advantage of the functionality of a
geometric network including tracing and routing.

4.1 POD Source

Shapes for Water Right PODs were initially developed from the Geographic Coordinate Data Base (GCDB)
as quarter-quarter (QQ) or quarter-quarter-quarter (QQQ) centroids based on the POD legal description.
As better location information becomes available, including digitized points and GPS data, updates to the
POD shapes are completed and entered into the database. The “DataSource” field within the IDWR
Water Right attribute table contains information about how the POD location was determined. There are
four main types of locations for POD’s; 1) digitized, either by placing a point on a paper or digital map, 2)
GPS - and downloaded into a GIS system, 3) Quarter-section centroid derivatives, either Q, QQ, or QQQ,
or 4) unknown (see Figure 4.1).
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GPS (31)
Digitized (687)
Unknown (118)
Nominal (2137)

eshoe d

Figure 4.1 — POD's in the Payette Subbasinby collection method.

It is common to have multiple POD “stacked” points for one spatial location, because there may be
multiple water rights/property owners diverting water out of one single POD structure. In addition, if the
POD is a centroid derivative (nominal), a spatial location can have multiple diversion sources; i.e., Payette
River and Shafer Creek (figure 4.2b).
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Water nght # Source

John Jones 1 Little Willow Creek

Jane Smith 2 Little Willow Creek

John Jones 3 Little Willow Creek

Dan Brown 4 Little Willow Creek

Mike Johnson 5 Little Willow Creek
— : .

Water Right 1

Water Right

Water Right 3_
WK .
Stacked Nomlnal POD Points

>

[ S

Water Right # POD Source
John Doe 1 Payette River
Jane Smith 2 Payette River
John Doe 3 Shafer Creek

Figure 4.2b — Example of a “Stacked” nominal POD in the IDWR Active Water Rights feature class
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For this study, four POD point feature classes were extracted from the IDWR Water Rights Database.
Only active Water Rights were used. The dataset containing named surface hydrography (containing
points of diversion where the “Source” field was populated with a named stream attribute) was the only
dataset of the 4 that could be verified. Verification of event placement was done by comparing the
NHDFlowline named feature attribute (GNIS_Name) and the “SourceFeature_ID” field. The remaining
three datasets were kept separate because of the difference of the surface hydrography contained within
each — streams, springs, and miscellaneous surfaces consisting of ponds, stockwater, etc. These
remaining three datasets did not have unique names within the “Source” field, so a verification using the
method of matching GNIS_Name of the NHD__Flowline with SourceFeaure_ID of the the event would not
produce usable results.

Points of Diversion for the Payette Subbasin

e Named - Matched
e Named - No Match
Unnamed

Misc. Surface

0

Springs

Figure 4.3 — Points of Diversion by Source
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Feature Dataset Summary:

Named Surface Hydrography. There were 1561 points in this feature class. All of these POD’s
were populated with named stream attributes in the “Source” field, which represents where the water is
diverted from. There were 559 digitized points and 42 GPS’d points in this feature class. The remaining
960 points were either derived from quarter-section centroids, or unknown.

Unnamed Surface Hydrography. There were 848 points in this feature class. None of these
POD’s had name attributes populated for the “Source” field, which would represent where the water is
being diverted from. There were 154 digitized points in this feature class. The remaining 694 points were
either derived from quarter-section centroids, or unknown.

Springs. There were 972 points in this feature class. All of these POD’s had name attributes,
although 94% of them were simply populated with “Spring” as the name. The remaining 6% had a spring
name associated with the “source” field, representing the spring name where the water was diverted from.
There were 116 digitized points, and 12 GPS points. The remaining 844 points were either derived from
guarter-section centroids, or unknown.

Miscellaneous Surface. There were 292 POD records in this feature class. All of these POD’s had
name attributes for the “Source” field, although 96% of them were simply populated with either “Pond” or
“Wastewater”. Of the remaining 4%, 9 records were unknown, and 2 had pond names associated with the
“source” field, representing where the water was being diverted from. There were 102 digitized points,
and 1 GPS point. The remaining 189 points were either derived from quarter-section centroids or
unknown.

In addition to the POD sources listed above, there are also active groundwater points of diversion in the
IDWR database. These PODs were not included in this study as creating groundwater POD events along
surface hydrography would not be a useful application for this project.

4.2 Tools and Methodology

The process of creating events from points using the HEM Tools (ver 2.2) was summarized in Appendix B
— Referencing Water Right PODs in the Payette Subbasin to the NHD using the Hydro Event
Management (HEM) Tools. This document outlines the steps needed to set up the HEM Tools, pre-
process the IDWR Water Right data, and create the point events that are discussed in this report.

Before POD events could be “snapped” to the NHDFlowline, initial processing was performed to ensure all
data used in the analysis was in the same projection. All IDWR data was projected to the Albers
projection used by the NHD to avoid any conflicts or errors. A dissolve was performed on the POD’s with
the same SpatialDatalD to avoid multiple point events being placed in the same location (see Figure
4.2a&b for example of stacked data). The dissolve process is done by using a command within Arcinfo
that aggregates features based on specified attributes, in this case, the aggregation( or dissolve) was based
on the SpatialDatalD field contained within the IDWR Water Rights Database. The SpatialDatalD is a
unique field that identifies each spatial location of a POD within the IDWR water rights database. The
POD'’s of many individual water rights can have the same SpatialDatalD if the water is diverted from the
same location on a natural source (Figures 4.2a&b). After the dissolve, a separate field was created in the
IDWR table called HEMCODE (text, 40), consisting of the unique IDWR “Spatial Data ID” value,
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separated by stream name (“Source”), and location information (i.e., GPS, QQ, etc.). After the dissolve,
each dataset contained one POD point per spatial location and surface water source. There are many
instances where there is more than one POD per location, but they have separate sources of diversion that
need to be preserved to illustrate separate diversions at the same spatial location.

| METHOD OF POD LOCATION COLLECTION

P - ¢ e s i

Active WR Named surface 914 46
BEFORE DISSOLVE

Active WR Named Surface
AFTER DISSOLVE

Active WR Unnamed Surface
BEFORE DISSOLVE

Active WR Unnamed Surface
AFTER DISSOLVE

Active WR Springs

BEFORE DISSOLVE

Active WR Springs

AFTER DISSOLVE

Active WR Miscellaneous Surface
BEFORE DISSOLVE

Active WR Miscellaneous Surface
AFTER DISSOLVE

Note: “WR” = “Water Right”

TOTAL — AFTER DISSOLVE | s+ 687 2137 18

Table 4.1 — Number of records, per dataset, before and after the dissolve

The HEMCODE field was used from the IDWR feature class to populate the Source_FeaturelD field in the
point event table (Figure 4.4). The process of creating point events via the HEM Tools is described in
Appendix B.

E® Transfer IDs; Select Link Fields

— Tranzfer Dz to Event Featureclazs

Select Field to Calculste IDs From: L. . X
= This is the field in the IDWR feature class
HEMCODE j

Select Field to Calculate 1Ds Into:
source_Featurell j This is the field in the events table the

HEMCODE attributes will transfer into
v
A

Figure 4.4 — HEMCODE field used to transfer attributes
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In a previous review of creating point events using the HEM tools, two ArcMap settings may have affected
the results of the analysis; Selection Tolerance and Snapping Tolerance. Both the Selection Tolerance
(Tools|Options) and the Snapping Tolerance (Editor|Options|General Tab) can be set in pixels. The value
of a pixel is dependent on map scale and can be highly variable. The following issues were identified
during the previous review:

1) Changing the Snapping Tolerance has no affect on the number of points that are referenced or the
number of candidates selected by the HEM tool. This was found to be true if the Snapping
Tolerance was set in either pixels or map units.

2) Selection Tolerance was found to affect the number of points that are referenced and the number
of candidates selected by the HEM tool.

Because a starting map scale, hence pixel size, was not specifically set before running the HEM Tools,
the pixel size setting is suspected as a cause of inconsistent results. For example, results could vary
greatly especially if the person using the tool was changing scale by zooming in to a candidate
segment.

A 212-record dataset (Appendix C) bounded by the Emmett and Letha Irrigation districts were compiled
as a test subset of the dataset. This subset was used to assess where events were located along the NHD
lines and the best methods to use for the entire study area. For the subset, each event record was
manually checked to assess whether or not it was correctly located. These checks were performed by
comparing feature names within the newly-created point event table with the NHDFlowline feature class
table, and comparing the placed event locations with any documentation that was available online via the
IDWR Water Rights database. After each location was checked, that point event was assigned an
attribute; Y-Correct Location, N-Incorrect Location, or U-Unknown. The methods used and the results of
that subset can be found in Appendix C — Test Study: Creating Events for the Emmett and Letha
Irrigation Districts.

Following the subset data analysis, point events were created on the NHDFlowline for all four of the
IDWR active water right feature classes in the Payette Subbasin, as described in section 4.3.

It was determined that suppressing the candidate form in the HEM Tools (Edit Tools|Options|Route
Location Options tab) was the best course of action, to avoid having to hand-pick the best location for over
2900 points of diversion and to avoid issues with the selection tolerance. If this option is not suppressed,
a dialog box comes up for each point that is within the specified search tolerance, and the user must
interactively choose the best route location for each point event (see Figure 4.5). On all feature classes
except for the springs, the option “Use closest candidate first, then top of the downstream” was selected,
forcing the event to snap to the closest stream without using the candidate form. Stream names were then
compared for the PODs with named features. For the springs, the option “Use top of the downstream
first, then use closest candidate” was preferred so that the event points would locate at the top of the
nearest stream segment when possible. For all iterations of the data, the “Round Events” option was
turned off so that each event would snap to the closest location on the NHDFlowline, rather than
snapping to the endpoint of each NHDFlowline. If the “Round Events” option is activated, events within
two measures of an endpoint will be rounded to the endpoint, i.e., events 0-2 will be rounded to 0, and
98-100 will be rounded to 100.
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Select Route Location
Select a Candidste:

Mare than one feature iz within the search tolerance.
Pleaze zelect which geametry wou wauld like the input
paint to znap ta.

T end of Reachcode = 17050122001 415 ComiD = 52251078
Mearest point on Reachcode = 17050122001 415 ComlD = 52251078
T end of Reachcode = 170501 22006275 ComiD = =505

Mearest poirt on Reachcode = 170501 22006275 ComiD = -505
FROM end of Reachcode = 17050122000574 ComiD = 52249054
Mearest point on Reachcode = 7050122000374 ComlD = 52249054
FROM end of Reachcode = 170501 22006275 ComiD = -506

T end of Reachcode = 170301 22006275 ComiD = -506

Mearest poirt on Reachcode = 170501 22006275 ComiD = -506

n Zoom to Feature Flash Feature

Figure 4.5 —the Hem Tools Candidate Form

5. Results & Discussions

Four separate IDWR Active Water Right geodatabases were created for the entire Payette subbasin study
using the HEM Tools (v2.2); Named Surface, Unnamed Surface, Springs and Miscellaneous Surface. Each
newly created event point geodatabase corresponds to the IDWR Active Water Right feature class that was
originally created for this study. It was decided to keep these geodatabases separate, as each provides
individual attributes unique to the Water Right records within IDWR, i.e., streams, springs, and
miscellaneous surface (wasteways, ponds) are all different features. In addition, it was advantageous to
separate the named features from the unnamed features so that a match could be performed on the
named features to verify accuracy. Separating each set of records also avoided having to add an additional
field and keep track of the type of water right. Also, processing time was shorter than it would have been
if all records had been grouped into one geodatabase. The results of the HEM Tool processing for each of
the four geodatabases are summarized below:

Named Surface: There were 1561 points in the original feature class and 1041 points remained
after performing the dissolve (including the 212 points from the test study). In this particular feature
class, all of the POD’s were populated with named stream attributes in the “Source” field, representing
where the water is diverted from. After using the “Import Points” feature of the HEM Tools (Edit
Tools|Import Points), 1035 point events were created, using the “Suppress the Candidate Form” option in
the HEM options dialog box. Six points failed to import. This represents a 99.4% success rate. Itis
unknown why the 6 points did not import; for further information on this issue, see Appendix D — Hem
Tool Error Report.

A separate analysis was performed to assess which named features in the POD_ Point_Events table
matched the NHDFlowline. The records with stream names that matched were considered correct
without further investigation. There were 551 name matches out of 1035 point events, which represent a
53% overall match based on stream name comparisons (Figure 5.1).
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Legend
POD Point Events

Matched
e Y

Figure 5.1 — Named Surface POD’s — matched (green) vs. unmatched (red)

Method of Collection Total Records Number Matched Percent
Digitized 366 214 58%
GPS 18 3 17%
Nominal (Q, QQ, QQQ) 609 309 51%
Unknown (Blank) 42 25 60%
TOTALS 1035 551 53%

Table 5.1 — Method of collection and percentage of matches for each — Named Surface Water Feature class

A number of key factors were identified for GPS points that we flagged as not matching stream names.
Surprisingly, in comparing names associated with NHDFlowlines and the names associated with the
water right PODs, only 3 of the 18 GPS points snapped to the correct stream. Seven of these points were
either injection or re-diversion sites. Injection or re-diversion sites are points when water is diverted out
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of one location, injected into another location, and re-diverted into yet another location. These events are
separate point of diversion records within the IDWR Water Rights database, but contain the same POD
source (usually the original POD). In these cases, the hydrographic names will possibly match the
NHDFlowline feature for only one source, the original diversion (see figure 5.2). Further investigation
and manual coding would need to take place in order to makes sure these points are placed in the correct
location. These points are probably in the correct location, but were flagged because the source name on
the POD did not match the hydrography of the closest stream

Code- Incorrect

braid of the Payette River

Stream Names don't match

~/ Water goes from point A i
Injected to point B
Rediverted to point C

Code - Incorrect -
braid of the Payette River |
Stream Names don't match

Code - Correct
Y Graveyard Gulch Wasteway
Name match

Figure 5.2 — Example of an injection and re-diversion site

There were three GPS points that were flagged as errors due to a braid in the stream. In the example

below, the diversion point is located on a major stream braid of the Payette River. The GPS diversion
point is located correctly and the diversion source is the Payette River, but the NHDFlowline name is

located along the main portion of the Payette River, not the unnamed braid. This causes a non-match
between the NHDFlowline and the IDWR Source code stream names (Figure 5.3).
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Figure 5.3 — Example of a major stream braid of the Payette River, causing a non-match between the source names

There were also non matches flagged due to the GPS point snapping to the closest NHDFlowline feature,
rather than the artificial path. This occurs because the GPS point was not digitized in the center of the
river, but at the diversion structure on the bank. This creates an issue because the nearest NHDFlowline
feature in these cases is not the artificial path. In the next example (Figure 5.4), the Payette River is the
source of diversion, and the point was GPS’d while standing at the bank and diversion structure.
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Another possible error was identified as slightly differing source names between the POD and NHD. The
NHDFlowline (artificial path) through the Sage Hen Reservoir is coded as “Sage Hen Creek”, while the
IDWR Water Rights database has the POD source listed as “Sage Hen Reservoir”. Further work may be
needed to correlate these names, either by updating the NHD or correcting the IDWR database, for
consistency. This may require checking and perhaps updating the Geographic Names Information System
(GNIS). The GNIS may have variants within their names that may be associated with the water rights
database but would not be listed as the name on the NHDFlowline. After review, the GPS point was in the
correct location, but flagged as an error because of the naming mis-match.

In one instance, there were two diversion structures within 115 meters of each other, with one named
stream (Little Creek) and one unnamed stream that appears to flow into Little Creek. If this is the actual
diversion point, then additional research will need to take place to determine if the stream names are
wrong, and Little Creek should be the unnamed portion of the stream at the GPS’d diversion point.
Another possibility exists that the GPS'd point should be at the named portion of the stream, and a field
error exists. Further review and coordination with the IDWR water right agents and/or irrigation
companies may need to take place to either correct the named portion of the streams, or re-examine the
GPS location of this point. See Figure 5.5
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Figure 5.5 — GPS point at unnamed portion of stream. Stream Name change? GPS point location wrong?

A separate analysis was performed to assess whether the 15 unmatched GPS points (fig 5.1) could be
snapped to the NHDFlowline using the NHD Area feature as a preliminary selection method since these
points had accurate GPS locations; and it was anticipated that they would intersect the NHDArea features
of the Payette River. By using the “select by location” tool within ArcMap, only three of the 15 unmatched
GPS points intersected the NHDArea feature. It was determined that this method of selection would fail
because the person collecting the GPS points was often standing on a diversion structure, or on the river

bank outside the NHDArea polygon area.

Unnamed Surface: There were 848 points in the original feature class and 792 points remained
after performing the dissolve. There were no named surface features in this feature class, thus no cross
check with the NHD GNIS named features could be performed. After importing the points via the HEM
tools, 790 event points were created, and 2 event points did not import. Again, it is unknown why the 2
points failed to import. This represents a 99.7% success rate for the number of points that would import

via the HEM tool for this category.
Springs: There were 972 points in the original feature class and 894 points remained after
performing the dissolve. Nearly all (94%) of these points had only “spring” as the named surface feature,
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thus no cross check could be performed with the NHD GNIS features. No manual cross check was
performed on the remaining 6% of the named features. After importing the points via the HEM tools, all
894 points successfully imported to events, representing 100% import success for this dataset.

Miscellaneous Surface: There were 292 points in the original feature class and 243 points
remaining after performing the dissolve. Nearly all (96%) of these features had attribute names of “pond”
or “wastewater” in the source field, so no cross check with the NHDFlowline GNIS features was performed
on this dataset. After importing the points via the HEM tools, 243 event points were created, and 3 points
failed to import. It is unknown why these points did not import. This represents a 98.7% success rate for
the number of points that would import in this category.

Un-imported Points: In processing the four categories; hamed streams, unnamed streams,
miscellaneous and streams, there were 11 points combined from all 4 shapefiles that did not import using
the HEM tools. A separate process using the ArcGIS Linear Referencing Tools was performed with these
points using the ArcMap Locate Features Along Routes Tool and Make Route Event Layer. Using the
ArcGIS method and a 100-meter buffer, all 11 remaining points imported successfully and snapped to the
NHDFlowline feature. None of the 6 named points snapped to the correct NHDFlowline, because the
closest feature was the Black Canyon Irrigation Canal, not the centerline of the Payette River at the Black
Canyon Dam (Artificial Path). Four of the 6 points had unknown methods of collection, while one point
was digitized, and one point was a QQ. The digitized point was located correctly, at the diversion
structure of Black Canyon Canal. Although this was the correct location for the diversion, the names did
not match, thus making this appear to be a name mismatch. It is not known why these 11 points imported
using the ArcGIS tools failed to successfully import via the HEM Tools. For more information on the
specific issues encountered during this process, see Appendix D “HEM Tool Error Report”.

The point events created with the ArcGIS Locate Features Along Routes Tool maintain the attributes from
the original point dataset and will maintain one field from the geometric network. This is nearly opposite
of the HEM tools which maintain all of the attributes from the geometric network needed to populate the
NHDPointEventFC but only one attribute from the original point dataset. An advantage of the HEM tool
is that it creates a point featureclass. A point feature class must be generated from the tables using Make
Route Event Layer tool after using the Locate Features Along Routes Tool. One major disadvantage in
using the HEM Tool method is not being able to create a selected set of features to narrow the range of
NHDFlowlines available for event snapping. This would be a very helpful addition to the tool, either by
allowing the user to specify NHD feature name criteria, or by allowing the user to specify a segment of the
NHDFlowline from which to locate the events. Suppressing the Route Location Candidate Form in the
HEM Tool Options was the most effective method for this study, as it was too time-consuming to
individually select over 2900 points and manually pick locations. Suggestions for improvement were
given to the HEM workgroup.

The HEM Tools provide a valuable resource for creating and managing spatial event data along the NHD
network because they maintain all of the attributes necessary to utilize the geometric network of the NHD
data model (v2.0). Using the techniques described in this report, 2959 event points (99.6%) were
successfully created in the Payette subbasin via the HEM tools. Eleven points did not import, but were
successfully imported using ArcGIS Tools. For an explanation of specific issues and problems during the
HEM Tool import process, see appendix D “HEM Tool Error Report”. This data has been forwarded in
the form of a large format paper map to the Letha Irrigation District for QA/QC of the surface water
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features within their district. As a result of that review, it is anticipated that work will continue as updates
and further revisions are received.

6. Establishing Procedures and Requirements for Referencing PODs in the Future

As the result of this study, several steps were identified as key components, in order to effectively create
and manage point events for additional subbasins within Idaho.

Obtain and Update Linework: Acquiring the most-recent canal and irrigation information from various
local agencies and stakeholders was identified as a critical first step before POD events could be correctly
located along the NHDFlowline. At the beginning of this study, a large amount of work was done to meet
with representatives from local irrigation entities, and provide them with paper and/or digital data, and
develop a method for data exchange. After the canal companies checked the areas in their district
boundaries, the revised lines and updates were sent to IDWR.

Check out Subbasin from NHD: When this data was received by IDWR, the Payette subbasin was checked
out from the USGS by the State NHD Data Steward (Technical Point of Contact), and work began to revise
the NHD with the new information supplied by the local agencies.

Revision: Before point events could be created, the NHD dataset had to be updated with the most-recent
linework supplied by the irrigation entities. For these edits, the NHD GeoEdit tools were used to
complete the revisions. In conjunction with this NHD update, 11 new GNIS named features were
identified and successfully submitted to the Geographic Names Information System (GNIS) for inclusion
into the national database.

Check in Subbasin to NHD: After the dataset had been revised, it was checked back into the NHD to
ensure it met the requirements for inclusion into the national repository.

Download Subbasin: After the subbasin had been QC’d and accepted back into the national repository by
NHD, it was downloaded for use with this project. During the editing process, the NHD Data Model was
upgraded to version 2.0, and this new edition was obtained in order to use the new version of the HEM
Toolset. Both new versions (HEM Tools and NHD data) were needed to utilize the “suppress selection
candidate” option that was only available in the new version of the HEM Tools, and only worked with the
new NHD 2.0 data model.

Obtain and Prepare the IDWR Water Rights Database within the Payette Subbasin: After consulting with
IDWR water right specialists, it was established that one point event (diversion structure) should be
referenced by its spatial location (IDWR unique “Spatial ID Number™), the diversion stream name,
(“Source”), and the collection method (GPS, digitized, QQ). This was preferred to having multiple event
points at the same location (“stacked” points) showing multiple property owners (see figure 4.1) using the
same diversion source at the same structure. Using this approach prevented stacked event points for the
same location and source, while allowing changes such as property sales, splits or transfers, to not affect
the accuracy of the Water Rights Spatial Data as modifications occur in the database. If additional water
right information is required, the SpatialDatalD number is linked back to the IDWR database for the most
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current water right records at each diversion site. For more information on the specifics of this process,
see Appendix C - “Test Study - Creating Events for the Emmett and Letha Irrigation Districts”.

Point Events were created using the HEM Tools: The HEM Tools were used to create point events for all
four feature classes created from the IDWR Water Rights Database. Instructions for completing this task
have been documented in the reference manual “HEM Tool Instructions (Appendix B), and described in
sections 4 and 5 of this report. Additional information can be found in Appendix C — “Test Study —
Creating Events for the Emmett and Letha Irrigation Districts.

QA/QC of the Named Streams: Although the procedure for referencing all points using the HEM tools
was consistent for all four datasets, records with named streams could be programmatically verified
through matching stream names. Events with stream names that matched the NHDFlowline (GNIS
Name) features were considered correct without further investigation. Some assessment was done to
assess the events that did not match, specifically GPS'd points, where a higher instance of match was
expected than was received. There were several key factors that influenced the accuracy results for the
named PODs that were not matched to the named NHDFlowline features, and those elements will be
further reviewed and, where possible, procedures will be refined in an attempt to eliminate some of these
errors in the future.

QA/QC of the Unnamed Streams and Features: All of the unnamed streams and other features (65%) will
require manual investigation to validate whether the snapped location was placed on the correct canal or
stream. PODs with historical nominal QQ centroids and unnamed POD sources provide an initial location
that is spatially referenced but further refinement is necessary in order to verify that the event
corresponds to the correct hydrologic feature. Using this same method for GPS and digitized points,
either with or without named streams, provides an excellent opportunity to spatially reference these
events using the NHD data model. As better spatial locations and information is entered into the IDWR
Water Rights Database, more accurate results will be obtained as a result of using these tools.

During this study, the HEM Tool methods used specifically for this project were documented in Appendix
B, “Hem Tool Instructions”, and Appendix C, “Test Study: Creating Events for the Emmett and Letha
Irrigation Districts”. Both of these documents were created to familiarize the user with this pilot study
and the steps that were required in order to create point events using the HEM Tools. As Cooperation and
coordination efforts with local irrigation entities continue, it is anticipated that additional POD locations
(i.e., headgate structures) maintained by the irrigation companies can be obtained and included as point
events into the NHD data model. As future updates are received, the initial procedures and requirements
that have been identified for this pilot study will be revisited and updated as needed.

6.1 Possibilities for Automating POD Referencing Statewide — Assessment

Establishing a process for automating the existing POD’s is also being investigated. As a result of this
study, it has been determined that an initial subset of the PODs with named surface diversions would be a
good starting point, as well as PODs with known GPS or digitized locations. IDWR staff currently works
with a correlation tool application using a 5-meter buffer. This system alerts the water right agent to
another point within 5 meters of the current point, and asks if the PODs are, in fact, separate points. It
might be possible to modify this tool to create events for GPS'd or digitized points.
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Also during the course of this study, it has been determined that it is not practical to define a process to
automate the nominally located POD points for two main reasons. First, because these points are located
in the center of each QQ section, there is no way to regulate with the current HEM tools which stream or
canal the point event would snap to for multiple points. Second, in these cases where a location would
need to be manually selected by using the HEM Tools “Selection Candidate Form”, it would be an
unrealistic use of time to get through the nominally-located POD points statewide. A two-step process
using ArcGIS to do an initial selection of these POD points before running the HEM Tools may be a more
efficient method, pending additional enhancements with the HEM tools.

The Idaho Department of Water Resources manages a relational database consisting of approximately
180,000 active water right records in Idaho. When a water right is created, transferred, or split, the
IDWR water right agent will initiate an update of the POD spatial location when applicable. IDWR water
right agents are familiar with GIS applications and use a large amount of spatial data to assist them in
locating the correct PODs and water right information. This would be an optimal time to initiate a
procedure to create or update event points as they are entered into the system. IDWR is currently
assessing methods by which the HEM Tools could be used as a background application as these points are
either created or updated, automatically snapping them to the appropriate canal or stream.

7. Time Requirement Assessment

This project was started in October 2009. In order to get the most recent and accurate canal and stream
data, a crucial first step was taken to gather information from local irrigation companies and stakeholders.
Considerable time was spent providing assistance and coordination efforts so that each stakeholder could
supply IDWR with their surface water updates essential to update the NHD. The approximate time for
this endeavor was 2-3 months. After these updates were received, the majority of time spent on this
project involved using the NHD GeoEdit Tools to complete the actual NHD updates and submit them to
USGS. This subbasin had to be re-downloaded and edited a second time to complete some minor GNIS
name edits. IDWR also downloaded the subbasin in the new 2.0 version of the data model. This entire
editing process took approximately 8 months to complete.

After the final edits had been resubmitted and accepted into the NHD, a copy was downloaded and the
HEM Tool analysis began. Creating point events using the HEM Tool applications as described in this
report and accompanying attachments, took approximately 6 weeks to complete, including assessing the
results of the study. In the future, it is expected that the processing time will be minimized as a course of
action has now been identified to optimally accomplish these tasks. In addition, it is hoped that with the
release of the new GeoEdit Tools, the editing process will be expedited, thus improving both the time it
takes to update NHD data, and the number of subbasins that can be populated with POD event data.

8. Conclusions

There are approximately 180,000 active water rights throughout the state of Idaho that can be categorized
into approximately 60,000 separate points of diversion structures. Diversion points that have a GPS
entry or have been digitized with good base data are the most favorable candidates for incorporating
statewide POD event points into the NHD model. Diversion points with named surface water sources are
also excellent candidates for inclusion into the NHD. Based on the pilot study, this would represent

Cooperative Agreement GO9AC00373 250






approximately 21,000 diversion points statewide, or 35%. The remaining POD points (approximately
39,000) are nominally located, or have an unknown value for collection method. These points would
require a considerable amount of time to verify they snapped to the correct location using the HEM Tool
approach described in this study.

An accurate and reliable representation of surface water data within the NHD was a key component to
this project. Before POD point events could be located along the NHDFlowline features, those features
needed to be accurately represented in the spatial data model. In order to accomplish this task, continued
collaboration with local irrigation companies and interested stakeholders was an important factor, and a
critical first step in this process. Additional surface water updates have been received from these
agencies, and further work will continue to update the NHD in the Payette subbasin as a result of this
analysis.

This study provided valuable insight into the distinctive type of information contained within the IDWR
Water Rights database, and how that information can be used to improve the NHD. IDWR gained a
better understanding of the challenges ahead, and the minimum requirements necessary to implement a
statewide system for incorporating POD event data into the NHD. The advantages of having an up-to-
date representation of the current canal systems in Idaho that are fully networked in the NHD will greatly
improve IDWR'’s insight into water delivery, and provide an unprecedented opportunity to compare and
model water use for various natural resources statewide.

9. Appendix

Appendix A: POD Interview Results
Appendix B: Referencing Water Right PODs in the Payette Subbasin to the NHD

Appendix C: Creating Events for the Emmett and Letha Irrigation Districts
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Appendix D: Hem Tool Error Report
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